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I. Introduction  
ULAB is an easy to use, portable, graphic data collection system, which can be used in 
a variety of ways in the classroom or in the field. It can be used: 
- as a versatile multimeter, for direct display of physical quantities measured by 

sensors connected to ULAB; 
- as a stand-alone datalogger for measurements independent of the computer with 

real-time display of measured data on the ULAB screen; 
- as an interface connected to a PC computer with real-time display of measured data 

on the computer screen. 
 

The ULAB datalogger is equipped with FLASH memory, which allows easy updating 
of the internal operating system software (firmware), the operating language and the 
sensor library. It allows storing up to 250,000 measurement points (512 KB) in multiple 
sets of data. The system can sample up to 6 sensors simultaneously, in sampling rates as 
high as 100,000 samples per second. A wide variety of sensors is available for connec-
tion to ULAB.  
 
 
Reading directions for this manual   
 
Chapter II provides all basic information about ULAB and its components.  
 
Chapter III describes the use of ULAB as a stand-alone datalogger.   
 
Chapter IV describes the use of ULAB with the computer and the Coach software.  
 
Chapter V describes the utility programs to display ULAB�s screen image on the 
computer and to update ULAB�s firmware. 
 
Chapter VI provides detailed technical specifications of ULAB.  
 
Read Chapter VII in case of troubles �  
 
Appendix I lists all CMA sensors available for ULAB 
 
Appendix II lists the sensors available in ULAB�s sensor library  
 
Appendix III provides a Quick Start Reference for experienced users.  
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II. Getting acquainted  
In this chapter you can learn basic operations of ULAB like the functions of the 
buttons, providing power, connecting sensors.  
 

1. ULAB components  
The ULAB package contains of the following items:  

- ULAB datalogger  
- Power supply 
- USB cable 
- PC serial cable 
- Carrying bag  
- User's Manual. 
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The ULAB datalogger is provided with:  
1.  A graphical LCD display consisting of 128 by 64 pixels; 
2.  A keypad with 10 buttons; 
3.  Four analog inputs to connect sensors with BT (British Telecom) plugs. These inputs 

have two measurement ranges between 0 and 5 V or between -10 and 10 V. All inputs 
can be used simultaneously as counter inputs; 

4.  Two digital inputs to connect ultrasonic and digital sensors; 
5.  A bus for the USB connection; 
6.  A bus for the serial port connection; 
7.  A bus for the external power supply. 
 

1 

 

Figure. The different parts of ULAB (top view, rear view & front view). The numbers refer 
to the text. 
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2. ULAB�s buttons 
The ULAB keypad consists of the following buttons:  
 
  

 
 
 
 
 
 
 
 
 
  
 

Figure. ULAB's keypad 
 

 
ON/OFF button  
for turning power on and off. This button is sunk to 
prevent pressing it by accident. To turn ULAB off, keep 
this button pressed about 3 seconds before releasing. 
When this button is pressed briefly, then it functions as 
the ESC button in menus and selection lists. 

 
SELECT/CONFIRM button  
for activating highlighted items 

 
MENU button  
for activating and closing a menu  

 
RUN button  
for starting and stopping a measurement 

 
HOME button 
for returning to the Home Screen 

 
GRAPH button  
for turning the graph on and off 

  
 

     
 

 

 
ARROW buttons for navigation:  
up, left, right and down  
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3. ULAB�s operating system  
ULAB is equipped with internal operating software 
(firmware). This menu-driven operating system can 
be used to select sensors, setup measurements, 
record and view the measured data.  
The firmware is stored in FLASH memory that 
does not lose its storage capabilities when power 
is removed or lost. During normal operation, the 
user cannot change the information stored there. The FLASH technology, however, 
allows easy update of ULAB�s operating system with the most recent version.  
As new functionality becomes available, you can download the software from the CMA 
website to your computer and update your ULAB. Check the CMA website 
(www.cma.science.uva.nl/english) for updates. Directions for downloading and 
updating are given in Chapter V.  

4. Computer and software requirements 
To use ULAB with the computer you need the Coach 5 version 2.3 software running on a 
Pentium II computer with Windows 95/98/2000/XP or NT system software with at least 
32 MB RAM and unused serial or USB port.  

5. Attaching ULAB to the computer  
ULAB�s computer connection busses are located at its rear side.  

5.1 Serial connection  

• Plug the round mini-DIN end of the serial cable into the serial bus on ULAB. 
• Plug the other end (9-pin plug) of the cable into the serial port on the computer.  
 

ULAB supports the following baudrates: 9600, 19200, 38400, 57600 and 115200 (default 
baudrate). If you want to change the baudrate or the COM port number, you can do it 
during installation of the Coach software, or later, in the main menu of Coach, under the 
option Tools>Install hardware drivers.   

5.2 USB connection  

• Plug the square end of the USB cable into the USB bus on ULAB. 
• Plug the other end of the USB cable into the USB port on the computer.  
Coach automatically detects USB connection. It is not necessary to specify any hard-
ware settings.  

6. Providing power to ULAB   
ULAB is powered by internal rechargeable batteries (located at the bottom of ULAB) 
or by AC power. When the external power adapter is not connected then ULAB uses its 
batteries.  
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To use ULAB with the AC power supply:  
• 
• 
• 

                                                

Plug the round plug of the power adapter into the bus on the rear side of ULAB.  
Plug the power supply into the outlet. 
The batteries must be inside other way ULAB will not function.     

The batteries are automatically charged after plugging the power supply into the outlet. 
The batteries are also charged when ULAB is connected to the USB port on the 
computer. In this case the charging process is slower than when using power supply.  
Depending on the type and number of used sensors ULAB functions between 4 and 10 
hours on a single battery charge.  
Warning: Use only the included 5-V power supply otherwise ULAB can be damaged.  

7. Connecting sensors  
Analog and digital sensors can be connected to inputs of ULAB. All inputs can be used 
simultaneously.    

7.1 Analog sensors 

Four input channels for analog sensors (CH1 � CH4) are located at the front side of 
ULAB. The analog channels accept British Telecom-style plugs with a right-hand connec-
tor1. All inputs have 2 measurement ranges: 0 to 5V and �10 to 10V.  

7.2 Counters  

All analog inputs of ULAB can be used (simultaneously) as counter inputs. Sensors which 
generate pulses such as the Geiger-Müller Ionizing Radiation Sensor (CMA art. nr 029) or 
the Smart Pulley (CMA art. nr. 0386) can be directly connected to these inputs.  
Sometimes it is useful to count signal changes of an analog sensor as pulses, e.g. to 
measure how often the screen is refreshed (using a light sensor as counter) or to 
measure the rate with which your heart-beats (using a heartbeat sensor as a counter). 
With ULAB it is possible to define analog sensors as counters. If the analog signal of 
such a sensor crosses a specified value (threshold) in a predefined direction, the counter 
is incremented by one.  

7.3 Digital sensors 

Two input channels for digital sensors (CH5 and CH6) are located at the rear side of 
ULAB. Two digital sensors or two Ultrasonic Motion Detectors can be connected to these 
inputs. The digital channels accept British Telecom-style plugs with a left-hand connector.  
Notice that analog and digital sensors are "keyed" differently, preventing them from being 
connected to the wrong port.  

 
 
1 All CMA sensors purchased after January 2001 are provided with British Telecom plugs and can be 
connected directly to ULAB. 
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7.4 Sensor recognition 

ULAB automatically identifies sensors when they are connected to ULAB input 
channels and uses pre-defined parameters to configure an experiment appropriate to the 
recognized sensor. This greatly simplifies the setup procedures for many experiments. 
ULAB recognizes Intelligent and Auto-id sensors2.  

• An Intelligent sensor has a memory chip with information about the sensor. 
Through a simple protocol (I2C) the sensor communicates with ULAB and trans-
fers its data (name, quantity, unit and calibration) to the datalogger.  

• An Auto-id sensor is equipped with a specific sensor resistor, which allows 
automatic identification of the sensor and using proper sensor data.   

 

When a sensor is physically plugged into an input channel of ULAB then ULAB 
automatically detects the sensor and acts as follows:  

- ULAB recognizes the connected sensor as an Intelligent sensor and displays cali-
brated signal values measured by the sensor. User can overrule this setting by se-
lecting another sensor from the ULAB Sensor Library. (See chapter III, § 4.1).  

or 
- ULAB recognizes the connected sensor as an Auto-id sensor with sensor informa-

tion stored in the ULAB Sensor Library and displays calibrated signal values 
measured by the sensor. User can overrule this setting by selecting another sensor 
from ULAB�s library. (See chapter III, § 4.1). 

or 
- ULAB recognizes the connected sensor as another type of sensor (Auto-5V or 

Auto-10 V) and displays signal voltage values measured by the sensor. To cali-
brate the measured signal the user has to select the proper sensor from ULAB�s 
Sensor Library. 

 

When a sensor is physically disconnected from ULAB then it acts as follows: 
- ULAB stops to display signal values of detected sensors (Intelligent, Auto-id, 

Auto-5V and Auto-10V sensors) 
or  

- ULAB keeps displaying signal values of user-selected sensors. The values remain 
in the screen and can be removed only by selecting the option None from 
ULAB�s Sensor Library.  

 

                                                 
 
2 The complete list of sensors can be found in Appendix 1. 
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III. Using ULAB as a stand-alone datalogger  
ULAB is able to collect and store measurement data independently of the computer. 
This is very useful for remote data collection e.g. outside the school. Setting up an 
experiment is easy and can be performed completely via ULAB�s keypad. The meas-
urement results are presented on ULAB�s display in the form of a graph or a table.  
 

As a standalone device ULAB can work in two modes:  
1. Multimeter mode - in this mode, ULAB displays the actual measured values of 

connected sensors as (large) digits or in graphical form. Measurements are not 
stored. 

2. Logging mode - in this mode experiments can be setup and performed. Measure-
ments are stored in ULAB�s memory.  

 
Both modes and their ULAB�s Screens are described in §2 and §3 of this chapter. In §4 
is described how to setup experiments with ULAB. As a start an overview is given of a 
typical measurement procedure with ULAB.  

1. Quick measurement procedure with ULAB  
1. Press  to switch ULAB on.  

After the introductory screens the Home Screen appears. ULAB is in Multimeter 
mode.  

2. Connect sensors to input channels of ULAB. 
In Multimeter mode ULAB constantly checks its input channels and detects con-
nected sensors. Depending on the type of connected sensor ULAB displays:  
- calibrated values for Intelligent sensors, and for Auto-id sensors defined in the 

local ULAB Sensor Library3; 
- voltage values for other sensors. To display calibrated values, select the sensor 

from ULAB�s Sensor Library: highlight the channel to which the sensor is con-
nected, press  and select the sensor.  

3. In Multimeter mode real-time measured values are displayed. Data are presented in 
a digital form in the Home Screen or after pressing  in a graphic form in the 
Multimeter Graph Screen. In this mode data are not stored.   

4. If you want to store the measured data, press . ULAB collects data according to 
the Experiment settings. The default Experiment settings are a time-based measure-
ment with a time span of 10 s and a sample rate of 50 samples per second. You can 
interrupt data collection before the measuring time is reached by pressing  
again or by pressing briefly .  

5. The measured data are displayed in a table. Use  to toggle between the table 
and the graph. Use the cursor keys to scroll through the data in the table or to scan 

                                                 
 
3 The default sensor library in ULAB is described in Appendix II.   
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the data in the graph after the measurement is finished.  
6. To repeat your measurement, press . The measurement data of a previous run 

are stored automatically in a data file named Run# (where # is a number between 1 
and 99).  See §4.3 for deleting data files. 

7. Press  to return to the Home Screen. 
8. Press  to activate the Experiment-Settings Menu where you can change the 

measurement settings and view stored data. (See §4.1). 
 

2. Multimeter Mode 
After turning ULAB on, it displays briefly the Title Screen and the Help Screen. After it 
the Home Screen appears. ULAB is in the multimeter mode and automatically detects 
connected sensors, identifies the channels to which they are connected, loads calibra-
tions for recognized sensors and shows the current readings. Readings of active chan-
nels are updated with frequency of 4 Hz. The real-time displayed data are not stored in 
ULAB�s memory. 
 

2.1 The Home Screen 

The Home Screen is the main screen of ULAB. It is the central point of ULAB opera-
tion. Pressing  always brings you back to the Home Screen except during the 
measurement runs.  
In the Home Screen, a cursor can be moved with  /  /  /  to high-
light any item in the screen. The figure on the next page shows the Home Screen layout 
and a description of all screen elements.  
 
In this Screen the additional user interactions can be performed: 
• By pressing  the Multimeter Graph Screen opens where the real-time collected 

data are displayed in a graph.  
• By pressing  the Experiment-Settings Menu opens. This menu allows viewing 

and modifying Experiment settings. If a computer set is active [!Set#] then its set-
tings are displayed.  
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LEFT  
the listing of  

all input channels  
[CH1], [CH2], �[CH6] 

MIDDLE  
the real-time signals of  
the connected sensors 

e.g. [23.6335 lx] 

RIGHT 
the computer Experiment 

settings indicated as  
[Set1], [Set2], [Set3]  

Pressing  when a chan-
nel is highlighted activates 
ULAB�s Sensor Library. This is 
only necessary for sensors 
that are not automatically 
recognized by ULAB.  
ULABs Sensor Library 
consists of 42 predefined 
sensors (see Appendix 2). 
 

To select a sensor from the 
sensor library: 
- highlight a desired channel 

with  /  
- activate the library with 

 
- highlight a sensor in the 

library with  /  
- confirm selection with 

. 

Intelligent sensors are auto-
matically recognized and their 
calibrated signals are 
displayed.  
Auto-id sensors are auto-
matically recognized if they 
are defined in ULAB�s Sensor 
Library. Then calibrated 
signals are displayed. 
Other sensors are automa-
tically detected and their 
voltage signals are displayed. 
These sensors have to be 
defined by selecting the 
calibration information from 
ULAB�s Sensor Library (see 
description in the left column).
 

Pressing  when a signal 
value is highlighted activates 
the Large Digits Screen. 

This part of the screen is 
activated only when Experi-
ment settings have been 
uploaded from the computer. 
The experiment settings 
consist of measurement me-
thod, measurement settings 
and sensor information. 
Maximal 3 Experiment settings 
can be uploaded to ULAB.  
Pressing  when a set is 
highlighted activates the set 
[!Set#] and its settings. 
Pressing  when an 
activated set is highlighted 
deactivates it [Set#]. 
At the bottom, right corner of 
the ULAB screen, the following 
items are displayed: 
- the computer connection 

indicator 
- the battery indicator 
- the clock. 
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2.2 The Large Digits Screen 

The Large Digits Screen displays the real-time 
measured values with large digits. To open this 
screen:   
1. If needed press  to return to the Home 

Screen. 
2. Highlight a sensor signal value with  / 

 /  / .  
3. Press . 
 

At the right side of the screen some extra information like the sensor connections 
display4, the battery indicator, and the clock, are displayed. In this Screen the following 
user interactions can be performed: 

By pressing  the Large Digits Menu opens. • 
By pressing  /  the displayed value cycles among the signals of the 
connected sensors. 

• 

By pressing  the Multimeter Graph Screen can be toggled on and off.  • 
By pressing  the Home Screen returns.  • 

 

The Large Digits Screen has its own specific menu that appears after pressing the Menu 
 button. This menu consists of the following options:  

[Dgt] - to specify the number of decimal digits to display: 
1. Highlight [Dgt] with  / .  
2. Select it with .  
3. Select a number from the selection list: [0], [1], [2], [3] or [4].  
4. Confirm with . 

[MnMx] - to turn on and off an extra display with information about a measured 
signal: 

1. Highlight the value of the [MnMx] option (either [On] or [Off]) with  / 
.  

2. Select it with . When [On] is selected then the following items appear:  
MIN: - the minimum signal value with respect to a reset point 
MAX: - the maximum signal value with respect to a reset point 
AVG: - the average signal value with respect to a reset point. 

3. Use [Reset] to reset the time moment from which minimum, maximum or av-
erage values are determined. 

The Large Digit Screen Menu closes by pressing  again.  

                                                 
 
4 On the sensor connections display the following symbols are used:  - indicates an active channel, 

 - indicates a non-active channel,  - indicates a trigger channel,  - indicates a pulse source 
channel. 
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2.3 Multimeter Graph Screen 

The Graph Screen in Multimeter mode graphs the 
real-time measured signals. The displayed data are 
not stored. To open the Graph Screen:  
1. If needed press  to return to the Home 

Screen. 
2. Press .  
 

The graph shows how the signal varies over time. By default, the y-axis displays the 
maximum range of the sensor.  
At the right side of the screen some extra information like the sensor connections 
display5, the battery indicator, and the clock, are displayed. In this Screen the following 
user interactions can be performed: 

By pressing  the Graph Menu opens. • 
By pressing  /  the displayed graphs cycles among the signals of the 
connected sensors. 

• 

By pressing  the Large Digits Screen can be toggled on and off.  • 
By pressing  the Home Screen returns. • 

 

The Graph Screen has its own specific Graph Menu that appears after pressing . 
This menu consists of the following options:  

[Zoom] - to zoom the graph (only works in vertical direction): 
1. Highlight [Zoom] with  / .  
2. Select it with . The cursor starts to blink.  
3. Zoom the graph in or out with  / . Confirm with . It can happen 

that the graph disappears from the screen. Use [Move] to place the graph back 
on the screen. 

 [Move] - to move the graph: 
1. Highlight [Move] with  / .  
2. Select it with . The cursor starts to blink.  
3. Move graph up or down with  / . Confirm with .  

 [Reset] - to return the graph setting to its default values:  
1. Highlight [Reset] with  / .  
2. Select it with . When the message: [Reset Done] appears, the graph is 

set back to its default settings. 
The Multimeter Graph Menu closes by pressing  again.  
 

                                                 
 
5 See footnote 4, page 15. 
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3. Logging mode 
After pressing the Run  button, ULAB starts to collect data according to the 
Experiment settings (detailed description in the next paragraph).  
For triggered measurements the measurement starts automatically when trigger condi-
tions are fulfilled.  
For the manual type of measurements, the message [Press  To Take a Sample] 
appears. Every time you press , a single reading is taken.  
The Run  button works only in the Home Screen, the Large Digits Screen and the 
Multimeter Graph Screen. The measurement can be interrupted at any time by pressing 

 again or pressing briefly .  
During a measurement the data are displayed by default in the table. Pressing  
displays the graph. The clock displays the lapsed measurement time. The data of each 
measurement are stored automatically in ULAB�s memory in a Run data file. The 
ULAB memory can contain up to 99 Run files. These files are accessible from the 
[Data] tab of the Experiment-Settings Menu.  

3.1 The Table Screen 

The Table Screen displays the data stored accord-
ing to the Experiment settings. This screen opens 
automatically after starting the measurement.  
At the right side of the Table Screen some extra 
information like the sensor connections display6, 
the number of a current run, the battery indicator, 
and the clock, are displayed.  
In this Screen the following user interactions can be performed (after the measurement 
is finished): 

By pressing  the Table Menu opens. • 
By pressing  /  one can scroll through the data in the table. By keeping the 
button pressed scrolling will go faster. 

• 

By pressing  /  the displayed sensor column cycles among the signals of 
the connected sensors.  

• 

By pressing  the Graph Screen can be toggled on and off.  • 
By pressing  the Home Screen returns.  • 

 

The Table Screen has its own specific menu that appears after pressing . This 
menu consists of the following options:  

[Time dgt] - to specify the number of decimal digits for the time column display:  
1. Highlight [Time dgt] with  / .  
2. Select it with .  

                                                 
 
6 See footnote 4, page 15. 
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3. Select a number from the selection list: [0], [1], [2], [3] or [4]. 
4. Confirm with . 

[CH dgt] - to specify the displayed number of decimal figures in the sensor column 
display: 

1. Highlight [CH dgt] with  / .  
2. Select it with .  
3. Select a number from the selection list: [0], [1], [2], [3] or [4].  
4. Confirm with . 

The Table Menu closes by pressing  again.  

3.2 The Graph Screen 

The Graph Screen displays the data stored accord-
ing to the Experiment settings. To open this 
screen:  
1. Press the Run  button to start a measure-

ment. 
2. In the Data Table Screen press the Graph  

button.  
 

At the right side of the Graph Screen some extra information like the sensor connec-
tions display7, the number of a current run, the coordinates of a selected point, the 
battery indicator, and the clock are displayed. In this Screen the following user interac-
tions can be performed (after the measurement is finished): 

By pressing  the Graph Menu opens. • 
By pressing  /  the displayed graph cycles among the connected sensors.  • 
By pressing  /  the cross cursor can be moved along the graph to read 
coordinates of measurement points. The coordinates of the selected point (x,y) are 
displayed at the right side of the screen.  

• 

By pressing  the Table Screen can be toggled on and off.  • 
By pressing  the Home Screen returns. • 

 

The Graph Screen has its own specific Graph Menu that appears after pressing the 
Menu  button. This menu is very similar to the Multimeter Graph Menu with some 
small differences in the Zoom function.   

[Zoom] - to zoom a selected part of the graph: 
1. Highlight [Zoom] with  / .  
2. Select it with . The cursor starts to blink.  
3. Move the cross cursor to the point around which you want to zoom out.  
4. Zoom graph in with  (vertical) /  (horizontal) or zoom out in with 

 (vertical) /  (horizontal). Confirm with  when you are ready. It 
                                                 
 
7 See footnote 4, page 15. 
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can happen that during zooming the graph disappears from the screen. Use the 
[Move] option to place the graph back on the screen. 

 [Move] - to move the graph: 
1. Highlight [Move] with  / .  
2. Select it with . The cursor starts to blink.  
3. Move the graph with  /  /  / .  
4. Confirm with . 

[Reset] - to return the graph setting to its default values: 
1. Highlight the [Reset] option with  / .  
2. Select it with . When the message: [Reset Done] appears, the graph is set 

back to its default settings. 
The Graph Menu closes by pressing  again.  
 

4. Preparing Experiment Settings 
The measurements are stored according to the experiment settings, which consist of:  
- sensor information (which sensor is connected to each channel) 
- the measurement method (time-based, event-based or manual) 
- the measurement settings (measuring time, sample rate and trigger conditions).  
The Experiment settings can be prepared manually directly on ULAB by using its 
buttons. The default ULAB Experiment settings are:   
- Sensors: sensors detected by ULAB or selected from the ULAB sensor library 
- Measurement mode: Time-based measurement  
- Time span: 10 s 
- Sample rate: 50 per s.  
The experiments settings can also be prepared on the computer by using the Coach 
software to define settings and upload them to ULAB. This procedure is described in 
Chapter IV. Using ULAB with a computer.  
 

To open the Experiment Settings Menu:  
If needed press  to return to the Home Screen. • 
Press .  • 

 

The Experiment Settings Menu consists of three tabs: 
1. /Sensors\  - for viewing and defining sensors and their connections, 
2. /Method\  - to select the measurement method and prepare measurement settings, 
3. /Data\ - for management of the data files [Runs]. 

Use  /  to highlight one of the tabs. Its menu appears below the tab bar. To 
change a menu item:   

Highlight the item with  /  /  / .    • 
Press . • 
Select the value/item from the selection list and confirm with . • 
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4.1 Sensors 

The /Sensors\ tab opens the Sensors Menu in 
which sensor connections can be viewed or 
modified, sensors can be selected and the function 
of each channel can be defined.  
In this Screen all channels are listed. A brief 
description of the connected sensors appear behind 
the channel name.  
To change a sensor connection or add a sensor connection:  

Highlight the desired channel [CH1], [CH2] � or [CH6] with  / .  • 
Select with . The ULAB Sensor Library appears. • 
Highlight the desired sensor with  / .  • 
Confirm the selection with . • 

 

The Analog input channels [CH1], [CH2], [CH3], [CH4] can have three functions:  
1. Analog channel [anl] - to display the analog value measured by sensor.   
2. Counter [cnt]  - to display the number of pulses counted by the sensor.  
3. Frequency [frq]  - to display the frequency of pulses counted by the sensor.  
The channel function is displayed behind the sensor description. To modify a channel 
function:  

Highlight the 3-letter function descriptor with  / .  • 
Select with . A selection list appears.  • 
Highlight the desired function and confirm with . After selecting the [Counter] 
or [Frequency] options, additional items regarding the pulse definition appear:  

• 

- The threshold value, which the signal has to pass to be counted (by default 50% 
of the sensor�s measurement range) 

- The direction in which the threshold should be passed (by default increasing ↑). 
Highlight an option and select the value (in % of the sensor�s measurement range) or 
direction ([up], [down], [both]) from the selection list.   

4.2 Method 

The /Method\ tab opens the Measurement Setting Menu which allows selecting the 
measurement type and measurement settings. Every measurement type has its own 
specific settings.  
To select a measurement type:  
1. Highlight the value of the option [Type] with  / .  
2. Select with . The Measurement Type Menu appears. There are three measure-

ment types available [TimeBased], [EventBased] or [Manual]. 
3. Highlight the desired option with  / .   
4. Confirm with . Which menu options will appear depends on the selected 

measurement type.  
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Time-based measurement 
Time-based measurement is a measurement type in which the readings are taken at 
regular time intervals according to the sample rate (the number of measurements per 
unit of time). Time is the independent variable; the measured quantities are the depend-
ent variables. Most measurements (approx. 90%) are of this type. 
With trigger settings you can specify signal conditions for one channel from which 
ULAB automatically can start a measurement. There are two trigger settings, which 
completely determine the state of the signal on the trigger channel: 
- the trigger level of the signal 
- the trigger direction at which the signal passes the trigger level.  
Once the measurement is started (by pressing ), ULAB starts recording when the 
trigger settings are fulfilled. When triggering is used it is possible to log also a number 
of samples before the trigger settings are fulfilled. For this option you can specify 
which percentage of the total time should be the pre-trigger time.  
 

The Time-based measurement menu consists of 
the following options:  

[TimeSpan] - to set the duration of the meas-
urement time (the value and unit have separate 
selection lists)  
[SampleRate] - to set the sample rate (the 
value and unit have separate selection lists) 
[TriggerChannel] - to select a Trigger channel and define Trigger conditions. By 
default the measurement is not triggered, the option [None] is selected. To define the 
trigger settings:  

1. Highlight [None] with  / .  
2. Select it with . The selection list 

displays a list of active channels.  
3. Select the trigger channel with  / 

 and confirm with . 
4. Now additional options appear to set the 

trigger direction ([↑ (up) ],  
[↓ (down)], [  (both)], the trigger level (value in % of the total sensor meas-
urement range) and the pre-trigger time (in % of the total time span).   

Event-based measurement 
Event-based measurement is a measurement type in which readings are taken each time 
a pulse (event) is received on a given input channel. The pulse is the independent 
variable; time and the other measured quantities are the dependent variables. It is 
possible to change the pulse settings, i.e. to specify the conditions when a signal is 
considered to be a pulse. An example of such an experiment is a titration experiment in 
which the falling droplets generate pulses, at which moment the pH or temperature is 
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measured.  
The measurement is stopped when the specified number of samples is reached or when 
the maximum duration is reached. 
 

The Event-based measurement menu consists of 
the following options:  

[PulseSource] � to specify the pulse settings: 
1. Highlight [None] or [CH#] with  / 

. 
2. Select it with . The selection list 

displays a list of active channels. 
3. Select the pulse source channel and confirm with . Now additional op-

tions appear in the menu to set the threshold direction ([↑ (up) ], [↓ (down)], [ 
 (both)] and threshold level (in % of the total sensor measurement range). 

[Nr Events] - to set the number of samples to be measured. 
[Max Time] - to set the maximum duration for the measurement (the value and unit 
have separate selection lists). 

Manual measurement  
Manual is a measurement type in which a single 
sample is measured (for all channels) each time 
the Select button  on ULAB is pressed. The 
measurement is stopped when the specified 
number of samples is reached or when the maxi-
mum duration is reached. 
 

The Manual measurement menu consists of the following options:  
[Nr of Samples] � to specify the number of manually taken samples. 
[Max Time] - to set the maximum duration for the measurement (the value and unit 
have separate selection lists). 

4.3 Data 

The /Data\ tab opens the Data Menu in which the 
available memory can be checked and stored data 
can be viewed, selected and removed.   
In the screen the status of the ULAB memory and 
all data files (Runs) are listed. Each data file is 
stamped with its size, date and time of recording.  
To clear ULAB�s memory:  
1. Highlight [Free Memory] with  / . 
2. Select with . The menu with the following options appears:  

[Delete All] � to remove all data files  
[Del Older Than 1 Day] � to remove data files older than 1 day 
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[Cancel] � to return to the Data Menu without deleting any data. 
To view or delete a data file:  
1. Highlight the desired [Run] file with  / .  
2. Select with . The menu with the following options appears:  

[Graph] � to display the data in the graph 
[Table] � to display the data in the table 
[Info Sensors] � to display an overview of sensor connections 
[Delete] � to delete the data file 
[Cancel] � to close this menu. 

3. Highlight the desired option with  / . Confirm with . What will 
happen depends on the selected option:   

Selecting [Graph] displays the graph of the selected data file. User options avail-
able on this screen are described in Chapter IV, § 2.2. 

− 

− 

− 

Selecting [Table] displays the graph of the selected data file. User options avail-
able in this screen are described in Chapter IV, § 2.1. 
Selecting [Info Sensors] displays an overview of sensors and its connections of 
the selected data file. Pressing briefly  closes this overview. 
Selecting [Delete] removes the selected Run from the list with all Runs. − 

− Selecting [Cancel] closes menu and returns to the Data Menu. 
Depending on the size of the data file ULAB can contain up to 99 runs. The files are 
numbered from 1 to 99; RUN1 is the oldest file.  

5. Other ULAB settings  

5.1 The Clock Screen 

ULAB is equipped with an internal clock. The time 
is displayed in the lower right corner of most 
ULAB Screens. To set the date and clock: 
1. Turn ULAB on. 
2. When the Title Screen appears press . The Clock Screen appears.  
3. Highlight a date or time element with  /  /  / . 
4. Press . The cursor starts to blink. 
5. Select the desired value with  /  and confirm with . 
6. Repeat this procedure for all items.  
 

To restore ULAB�s factory settings proceed as follows: 
1. Select the option [Restore Defaults]. 
2. Confirm with . 
3. Press  to return to ULAB�s Home screen. 
With this procedure the memory of ULAB will be erased, including the measurement 
runs, the user-made Experiment settings and the computer Experiment settings (if 
uploaded). 
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5.2 The Help Screen  

After the Title Screen ULAB displays its Help 
Screen for few seconds. To keep the Help Screen, 
press  when the Screen is active. Press  
to open the Home Screen. 
  

6. Tutorial: temperature measurement with ULAB 
Using this step-by-step tutorial you can 
perform your first measurement with 
ULAB. This tutorial guides you through a 
simple measurement with a temperature 
sensor.  

Materials 
- ULAB  
- CMA Temperature sensor (art. nr 

0511) which is an auto-id sensor 
- 250-ml beaker and 100 ml hot water 

Measurement procedure 
1. Turn ULAB on by pressing . ULAB displays its introductory Screens followed 

by the Home screen. 
2. Plug the CMA Temperature sensor (0511) into input channel 1. ULAB automati-

cally identifies the temperature sensor and displays the sensor readings in °C.  
3. To see the real-time graph press . The data are not stored in the memory yet.  
4. Press  to return to the Home Screen. 
5. Fill a beaker with hot water and place the temperature sensor in the water. 
6. Press  to start a measurement. ULAB records data according to its default 

measurement settings (a time-based measurement with a time span of 10 s and a 
sample rate of 50 samples per second). The measurement stops as soon as the time 
span is reached. You can interrupt the data collection earlier by pressing  again. 

7. During the measurement the data are displayed in a table. Press  to toggle 
between the measurement table and the measurement graph.  

8. Use the cursor keys to scroll through the data in the table or to scan the data in the 
graph.  

9. Evaluate your results. If needed you can change the Experiment Settings by pressing 
 in the Home Screen.  
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IV. Using ULAB with a computer 
To use ULAB in combination with a computer you need a PC computer with the Coach 
software.8 There are two ways that ULAB can be used with the computer and Coach:  
 
On-line use 
In an on-line situation, ULAB stays connected to the computer (via a COM or USB 
port) throughout the measurement. Sampled data are transferred in real time to the 
computer. The course of the measurement can be followed directly on the computer 
screen in Coach. 
 
Off-line use 
In an off-line situation, ULAB is disconnected from the computer during the measure-
ment process. The measurement is performed according to ULAB Experiment settings 
or uploaded Coach Experiment settings. Sampled data are stored in ULAB�s memory. 
These data can be downloaded to the PC for further data analysis and processing 
afterwards. Advantages of the Off-line mode are that measurements are possible in all 
kinds of locations and that during long-term measurements the computer stays available 
for other tasks. 
 

In §1 of this chapter basic information about the Coach 5 program is given. A typical 
measurement procedure with ULAB and Coach is described in §2.  

1. Working with Coach  
Extensive information on working with Coach 5 can be found in the Coach User 
Manual Guide to Coach 5 and in the on-line Coach Help System. This paragraph 
describes only those Coach features/functions relevant for measurements with ULAB.   

Starting Coach 5  
Install Coach on your computer according to the Coach 5 Installation Guide. To start 
Coach 5 in Windows 95/98/NT/2000/XP/ME click on the Windows Start Menu, move 
to Programs and select CMA Coach 5 > Measurements > CMA ULAB. 

Hardware settings 
Make sure that the ULAB driver is installed during the Coach installation9 (see the 
Coach Installation Guide). To change the ULAB driver settings in Coach:   
• 

                                                

Select Tools > Install hardware drivers in the Start menu or Project menu of the 
Author version or press the Install hardware button in the Start menu of the Student 

 
 
8  As it is s possible to develop your own software to control ULAB (for example in LabView or Java) 

the description of the command list and the data formats for ULAB are available on request from 
CMA.  

9 The ULAB driver (ULAB.DLL) should be added to the drivers in the column labeled To install. 
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version.  
Select the ULAB driver (ULAB. 
DLL) in the column labeled In-
stalled.  

• 

• 

• 

You do not have to make any 
settings when using the USB con-
nection. 
When using the serial connection 
specify the port number and the 
baudrate (default 115200).  Figure. Hardware settings window

Opening a Project in Coach 
In Coach, a project is a set of related Activities. An Activity is an individual exercise 
that a student can perform. The list of projects is displayed automatically after starting 
Coach or by clicking the Open Project button. 
• Select the Project that you wish to open.  
• Click OK.  

Opening an Activity in Coach 
The list of activities is displayed automatically after opening a project or by clicking the 
Open Activity button. 
• Select the Activity that you wish to open. 
• Click OK. 

Important Coach Activity buttons   
Coach is controlled mainly via the buttons in the toolbar or by right clicking items on 
the screen. Here follows an overview of the most important buttons. Tool tips in Coach 
with a short explanation are also available. 
 
 

 
Open an Activity 
to open an Activity 

  
Open / Save a Result 
to open and save results  

 
Print  
to print the whole screen 

  
Show/Hide Panel  
to show or hide the datalogger panel on the screen 

 
Measurement settings  
to change a measuring time and frequency, trigger conditions  

  
Start to start a measurement on-line 
Stop to interrupt a measurement on-line 
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 Take measurement  

to take a single reading on-line 

 Replay  

  
Send settings to upload the experiment settings to the datalogger 
Get result to download the measured data from the datalogger 

    
 

     

Yellow buttons  
to display meter, value, graph, table, and  
to select text, pictures, videos, notes or links to Internet 
pages 

 
Help 
to open online help 

 

On-line Coach Activity for ULAB 
In this type of Coach Activity only the green Start button is available. During the on-
line measurement ULAB stays connected to the computer, collects data and sends it to 
the computer after each point is taken. The measured data appear real-time on the 
computer screen.  
When Coach communicates on-line with ULAB then the small computer icon  is 
displayed on the ULAB screen and the ULAB buttons are inactive. In this mode Coach 
acts as the Master and ULAB as its Slave.  
The data measured in the on-line Activity are not stored in the ULAB memory and 
should be saved in Coach. 

Off-line Coach Activity for ULAB 
In this type of Coach Activity as well the Send settings and Get result buttons as the 
green Start button are available. So, Off-line activities can be used as well to set up 
ULAB for remote data collection as for on-line measurements10. By clicking the green 
Start button the on-line measurement is started. By clicking the Send settings button the 
Experiment settings (measurement settings and sensor information) are uploaded to 
ULAB. Then ULAB can be disconnected from the computer and remote measurements 
can be performed. After the measurements have finished, ULAB is reattached to the 
computer. By clicking the Get result button, the contact between ULAB and the 
computer is re-established and the measurement results will be downloaded to Coach. 

Automatic sensor detection for ULAB activities  
For Coach Activities with ULAB, two kinds of sensor icons are used: normal and 
detected.  
Normal sensor icons can be selected from the Coach sensor library, placed on the 
Sensor palette or on the screen Panel by the user. Detected sensor icons are used for 
                                                 
 
10 To set an on-line Activity to Off-line, check in Coach the Off-line measurement checkbox, under 
Options > Activity options. 
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sensors automatically recognized by ULAB (see Chapter III, § 4.4). These sensor icons 
exist only on the on-screen ULAB panel and cannot be moved by the user. When the 
mouse cursor is placed above a detected sensor icon then the tool tip hints that it is a 
[detected sensor] (see the figure below). 
 

Figure.  A normal (left) and detected (right) temperature sensor. The shape of the mouse
cursor indicates that the normal sensor icon can be moved while the detected sensor cannot. 

 

When a sensor is physically connected to an input channel of ULAB then, depending 
on the current settings on the on-screen ULAB Panel, Coach acts as follows (usually 
within few seconds): 
1. there is no sensor icon on this Panel input  - then the sensor icon corresponding to 

the detected by ULAB sensor appears on that Panel position;  
2. there is a normal sensor icon on this Panel input - then nothing happens, the 

normal sensor icon remains on the screen panel. ULAB follows the Coach calibra-
tions.   

When a sensor is physically disconnected from an input channel of ULAB then, 
depending on the current settings on the on-screen ULAB Panel, Coach acts as follows 
(usually within few seconds): 
1. there is a detected sensor icon on this Panel input - then the detected sensor icon 

disappears from the Panel;  
2. there is a normal sensor icon on this Panel input - then the normal sensor icon 

remains on the Panel without any change. ULAB follows the Coach calibrations. 
When the user tries to replace a detected sensor icon by dragging a normal sensor icon 
on it then the question Replace the currently connected sensor? appears on the com-
puter screen. Clicking Yes replaces the detected sensor icon by the normal sensor icon. 
Again ULAB follows the Coach calibrations.  
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2. Computer measurements with ULAB and Coach 
Exemplary Activities for ULAB are available after installation of Coach 5. These 
Activities are described in the Coach Workbook. Most of them combine on-line and 
off-line measurements; as well the green Start button as the Send settings and Get 
results buttons are available. In some Activities sensors are already connected to the 
right inputs of the datalogger Panel, in other Activities one can use automatic sensor 
detection or choose a normal sensor icon from the Sensor palette and drag it to the an 
input of the ULAB panel. 

2.1 A typical measurement procedure in Coach 

1. Connect ULAB to the computer. Turn ULAB on. 
2. Connect sensors to ULAB. 
3. Start Coach and open a Project and an Activity.   

If the Activity is defined for another interface (e.g. CoachLab II) then the warning 
message Coach cannot initialize the panel CoachLab II �  appears on the screen. 
Click the Select other button. From the list of available Panels select ULAB and 
click OK.  If you want to keep this Activity for ULAB you have to save it in Author 
mode (by pressing <F2>). 

4. Follow the instructions in the Activity. If needed change the Experiment settings 
(Measurement settings and sensor connections).    

5. For an on-line measurement, click the green Start button to start a data collection. 
The course of your measurement can be followed in real-time on the computer 
screen. During the on-line measurement ULAB displays the message [Measurement 
Running]. 

6. To prepare ULAB for a remote experiment, upload the Coach Experiment settings 
to ULAB by clicking the Send settings button in Coach. When the upload process is 
completed Coach briefly displays the message The Experiment settings have been 
sent successfully. The uploaded computer Experiment settings are placed as [Set1] 
and automatically selected !.  
(Maximal 3 Coach Experiment settings can be stored in ULAB. When 3 sets are 
already placed in the ULAB memory then the next uploaded set is stored as [Set1] 
and the old [Set1] becomes [Set2], the old [Set2] becomes [Set3], and the old [Set3] 
is deleted.  
It is possible to activate one of the Sets in the Home Screen of ULAB.  

7. After uploading the settings, disconnect ULAB from the computer and turn it off. 
When you are ready to perform your measurement, turn ULAB on. Automatically 
the last uploaded Experiment settings are selected; if needed select other Experi-
ment settings (Coach or ULAB settings). Start the measurement by pressing .  
Detailed information about working with ULAB as a standalone device can be 
found in Chapter III. 

8. After the remote measurements have finished, you can download the measured data 
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to Coach for further processing. Reconnect ULAB to the computer. If necessary 
first start Coach and open an Activity.  

9. Click the Get result button in Coach. 
The Retrieve Data window appears on 
the screen. All data files (together with 
the file id, date, time and size) stored in 
ULAB�s memory are listed in this win-
dow.     

 
 
 
 
10. Select the Run you want to upload. By clicking the 

Info button an overview of the Experiment settings 
of the selected Run are shown.   

 
 
 
 
 
 
 
 
11. Click the Retrieve button to download 

the measured data to Coach.  When the 
Experiment settings of the received re-
sults do not match the Experiment set-
tings in Coach then the message appears 
on the screen.  

 
 
12. Click Yes to replace the current Coach settings with the settings of the received 

results. If the Experiment settings contain a user-defined sensor, which is not in the 
current Coach settings, then a blank sensor icon appears on the Panel. It is no longer 
possible to start a measurement or upload Experiment settings, until the blank sen-
sor icon is replaced by a normal sensor icon.   

13. After downloading, the data appear in a Diagram and Table and can be saved in 
Coach.  

14. Analyze the data. All processing and analysis tools of Coach are available from the 
Diagram and Table Tool menus (right click the diagram/table window or click the 
Hammer button.  
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3. Tutorial: temperature measurements with ULAB and Coach  
Guided by this step-by-step tutorial you can perform your first temperature measure-
ments with ULAB and a computer.  
Before you start make sure that the Coach 5 software is installed on your computer and 
you are able to connect ULAB to your computer by means of the PC serial cable or the 
USB cable. Make sure that Coach has the correct ULAB driver settings (communica-
tion port, its number and baudrate). 

3.1 On-line temperature measurement  

In this experiment you are going to investigate temperature variations of water in a 
beaker. During this on-line measurement, ULAB is connected to the computer. ULAB 
collects the temperature data, displays the measured data on the screen in a graph, a 
table and as a digital value. The measured value is also displayed on the sensor icon on 
the ULAB Panel. 

Materials 
- ULAB  
- PC computer with the Coach 5 program 
- CMA Temperature sensor (art. nr 0511) 
- 250-ml beaker and 100 ml hot water 

Measurement procedure 
1. Connect ULAB to the computer.  
2. Turn ULAB on by pressing . 
3. Start Coach 5. Open the project ULAB - 1. Tutorial and select the activity On-line 

temperature measurement.  
4. Plug the CMA Temperature sensor (0511) in input channel 1 on ULAB.  
5. The temperature sensor will be recognized by ULAB and its icon will appear 

automatically on the ULAB Panel on the computer screen. If you use another tem-
perature sensor then drag its icon from the sensor palette to input 1 of the ULAB 
screen panel.  

6. The measured temperature value is displayed in digital form in the Value window 
and on the sensor icon. Determine the room temperature.   

7. Fill a beaker with hot water and place the temperature sensor in the water. 
8. The predefined measurement settings are (check by clicking the Measurement 

settings button):  measuring time = 3 minutes, sampling frequency = 50 per second. 
Click the green button to start a measurement.  

9. To see a graph and data table click the Hide panel button.  
10. The measurement stops after the measuring time is reached or by clicking the red 

stop button. 
11. Analyze the measured data. All processing and analysis tools of Coach are available 

from the Diagram and Table Tool menus (right click the diagram/table window or 
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click the Hammer button. 
 

 

 

 

 

 

 

  

 

3.2 Off-line temperature measurement  

In this experiment you are going to investigate temperature variations of water outside 
the classroom. During this off-line measurement, ULAB is disconnected from the 
computer. The Experiment settings are uploaded to ULAB and the measured results are 
downloaded to Coach after the data collection is completed. 

Materials 
- ULAB  
- PC computer with the Coach 5 program 
- CMA Temperature sensor (art. nr 0511) 
- 250-ml beaker, 100 ml hot water, refrigerator  

Measurement procedure 
1. Connect ULAB to the computer.  
2. Turn ULAB on by pressing . 
3. Start Coach 5. Open the project ULAB - 1. Tutorial and select the activity Off-line 

temperature measurement.  
4. Plug the CMA Temperature sensor (0511) to the input channel 1 on ULAB. 
5. The temperature sensor will be recognized by ULAB and its icon will appear on the 

ULAB Panel on the computer screen. If you use another temperature sensor then 
drag its icon from the sensor palette to the input 1 on the ULAB screen panel. 

6. The measured temperature value is displayed in digital form in the Coach Value-
window and on the sensor icon.  
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7. The predefined measurement settings are (check by clicking the Measurement 

settings button) measuring time = 3 minutes, sampling frequency = 50 per second.  
8. Upload the Experiment settings to ULAB by clicking the Send settings button.  
9. When Coach displays that the Experiment settings have been transferred success-

fully, you can disconnect ULAB from the computer. You can measure temperature 
of hot water in a beaker or measure temperature outside of the classroom for exam-
ple inside a refrigerator (do not forget to cover ULAB in its case).  

10. Start the measurement by pressing .  
11. When data collection is complete re-connect ULAB to the computer.  
12. Start Coach and open the activity. Press the Get result button. Select the measure-

ment run from the list. Click the Retrieve button and wait a few moments while 
Coach retrieves the data. The measured data appear on the screen in the Diagram. 

13. Analyze the measured data. All processing and analysis tools of Coach are available 
from the Diagram and Table Tool menus (right click the diagram/table window or 
click the Hammer button0. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3 Manually-triggered temperature measurement  

The Coach project ULAB - 1.Tutorial consists of another two tutorial Activities: 
3. Manually-triggered measurement on-line and 4. Manually-triggered measurement 
off-line. Perform these activities to learn how to perform  manually-triggered measure-
ment with ULAB and Coach. The text included in the Activities will guide you step-by-
step through the measurements.  
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V. ULAB utility programs   
Two additional and simple utility programs for displaying ULAB screen and upgrading 
ULAB firmware are available.  Both programs are located in the Coach 5 folder.  
 

1. ULAB View  
ULAB View is a program which sends the image of the ULAB screen to the computer 
screen. In this way all students can easily follow teacher demonstrations.  
ULAB View is easy to use. Simply connect ULAB to the computer and turn it on. Click 
ULABView.exe file in the Coach 5 folder. The program automatically displays the 
current ULAB screen. Such a screen display can be captured and saved as a bitmap file 
 (*.bmp) by pressing the <F2> key or by left clicking. A Save as� dialog appears to 
store the BMP. This feature is very useful for creating teaching materials. 
Close the program by clicking the Close button in the upper right corner of the ULAB-
View window. 
 

2. ULAB Update 
ULAB Update is a program to update the internal operating system software of ULAB 
(firmware). The ULAB firmware file has the following format ULAB*.hx2 where * 
stands for the firmware version. With a firmware update it is e.g. possible to add new 
functionality to ULAB. 
The file corresponding to the firmware installed on ULAB can be found after installa-
tion of the Coach 5 program (in the Coach 5 folder). The newest version of the firm-
ware can be downloaded from the CMA website: http://www.cma.science.uva.nl.  
 

To update ULAB: 
1. Download the newest version of the firmware file and save it to the Coach 5 folder. 
2. Read the documentation accompanying the firmware update to know what changes 

in ULAB functionality are implemented. 
3. Connect the power supply to ULAB and plug into the outlet.  
4. Connect ULAB to the computer and turn it on.  
5. Start the ULAB Update program by double clicking the ULABUpdate.exe file in the 

Coach 5 folder.  
6. Under ULAB connection select the port to which the datalogger is connected (USB 

or COM port). 
7. Press the Start update button.  
8. From the list of available firmware files select the downloaded firmware file 

ULAB#-*.hx2 (# - the firmware version number; * - the firmware language). 
9. The following message appears Updating the firmware clears all data in ULAB�s 

memory. Update the ULAB firmware using ULAB. hx2?  
10. Pressing Yes starts the update process. At the end of this process ULAB will reset 

itself. 
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11. When the firmware is updated then the message appears: The firmware update 

process has been completed successfully. ULAB is updated to firmware version *.  
 

VI. Technical specifications of ULAB  
ULAB is a small handheld computer dedicated to the task of data collection. It contains 
a microprocessor that can communicate with a PC computer. This chapter gives 
detailed technical specifications of ULAB.  

1. Connection to the computer  

1.1 USB connection 

ULAB can be connected to the PC using a standard USB cable11. 

1.2 Serial connection 

For data transmission ULAB is connected to the computer via an RS-232 serial cable. 
Always use the included cable to prevent malfunction. The pin configuration of the serial 
cable is described in the table below.  
 

8-pin male mini DIN (ULAB) DB-9pin female (Computer) 
3 TD (Transmitted Data) 
5 RD (Received Data) 
4 GND (Signal Ground; common) 

2  RD (Received Data) 
3 TD (Transmitted Data) 
5 GND (Signal Ground; common) 

All other pins are not connected 
 

2. Power supply 
ULAB is powered by 2 internal NiMH batteries (1.2 V, 2700 mAh). The batteries can 
be charged via the included external 5-V power adapter or via the USB connection. We 
strongly recommend not to use any other power supply. 
If power supply is connected to ULAB the batteries will be charged regardless if ULAB 
is on or off. It takes about 12 hours to fully charge a discharged battery. However, if 
current-demanding sensors are connected, the available current for charging will be less 
(or even zero).   
Supplying ULAB and charging the batteries via USB will only occur if ULAB is 
switched on and if the USB hub has ensured to be able to deliver a current of 500 mA. 
The charging time will be approximately the same as when using the external power 
supply. The batteries cannot be overloaded, so it is no problem if the external supply 
stays connected for a longer time. In order for ULAB to start up, it is necessary that the 
                                                 
 
11 To use the USB connection you need a Pentium II computer with Win98 Second edition, Win2000 
or higher.    
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batteries is not fully depleted; if so, wait a few moments so the external supply can 
charge the battery a bit. With fully-depleted batteries, charging via the USB is not 
possible.  

2.1 Lifetime of the batteries  

ULAB functions (continuously) for approximately 10 hours on a fully charged battery 
provided there is little current drawn by connected sensors. If current-demanding 
sensors are connected (like the Ultrasonic Motion Detector or CO2 sensor), the ULAB 
battery may give up after 4 hours of continuous use.  
If measurements are performed with long inter-sample times (i.e. 10 seconds or more), 
ULAB switches itself off between the samples. Battery charge may last up to several 
months now, depending on the sample rate and on the time the sensors need to power 
up prior to the sampling moment. E.g. if the sensors need power prior to sampling 1 
second before sampling, battery charge will be 15,000 � 36,000 samples (depending on 
the current demand of the sensor(s)).   
With normal use the batteries have a lifetime of several years.  

3. Analog to Digital Conversion 

3.1 Resolution 

ULAB uses a 12-bit ADC. The 12-bit resolution results in a voltage resolution of 1.22 
mV for the 0-5V range, and 4.9 mV for the -10 to +10V range. 

3.2 Sample rate 

The maximum sample rate depends on the number of used channels and the way the 
channels are used. The following table gives an overview: 
 
 

Number of inputs used Maximum sample rate 
One analog input 
Two analog inputs 

Three analog inputs 
Four analog inputs 

One counter 
Four counters 

One counter + one analog input 
One motion detector 
Two motion detectors 

One motion detector + analog input(s) 
One motion detector + counter input(s) 

100 kHz 
10 kHz 
4 kHz 
4 kHz 

4 kHz sampling; 2 kHz max. signal frequency 
4 kHz 
4 kHz 
50 Hz 
25 Hz 
50 Hz 

not possible 
 

 36



ULAB User�s Manual  VI. Technical specifications of ULAB 
 

4. Memory 
ULAB is equipped with 128 KB of Flash (non-volatile) memory and 512 KB of SRAM 
(volatile) memory. Flash memory contains: 

the ULAB internal operating system (firmware)  • 
• 
• 

• 
• 
• 

the local (permanent) sensor library 
several other ULAB parameters.  

 

SRAM contains: 
computer Experiment Settings (up to 3 sets) 
sensor definitions used in the experiments 
measured data files � Runs which can consist up to a total of 250,000 data points 
(max. 100,000 per Run). 

 

If ULAB is switched off, all memory contents - Flash and SRAM - are maintained. 
SRAM is maintained as long as the battery is not completely depleted; Flash is always 
maintained. However, the Flash memory can be rewritten to update the local sensor 
library and the firmware.  
 

5. Display  
ULAB has a graphic LCD display of 128 by 64 pixels which shows the menu-driven 
internal program and measurement data (values, graphs and tables).  
 

6. Inputs 

6.1 Analog inputs  

The four analog input ports labeled 1-4 are used for analog sensors with right-hand BT 
connectors with the following pin-outs: 
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Note:  
The BT plug has two signal pins Vin (pin 1)
and Vin-low (pin 6). The input range of pin 1
is -10V to +10V, and of pin 6 is 0 to +5V.  
In the Coach software it is possible to
select the range i.e. to select the pin of
which the signal will be taken (see the
Coach Help System, keyword 'Input
range'). The default range is 0 to +5 V (pin
6). This applies to sensors with BT plugs
connected to an input channel of ULAB.  
For connected sensors with 4-mm plugs
via adapter art. nr. 0519 always the
standard range 0 to +5 V (pin 6) is taken,
regardless of the software settings. (In this
adapter there is no connection between
the yellow lead and pin 1). 

 

Pin Analog Input 1 - 4 
 

 
Right-hand connector 

1 Vin 
2 Ground  
3 Vres1/I2C3 data 
4 Auto-ID2/I2C3 clock 
5 +5 V DC 
6 Vin-low 

 
 
1 Vres - Output reference voltage (pull-up resistance 15 kΩ) for resistance measurements. 
2 Auto-id (pull-up resistance 10 kΩ)  - Auto-id sensor detection data input. The BT inputs have the 

possibility for automatic sensor recognition. 
3 For (I2C) communication between ULAB and intelligent sensors. 
 

 Vin (pin 1) Vin-low (pin 2) 
Inputs Input 1- 4 Input 1-4 
Input signal  Analog data  Analog data 
Input range  -10 to +10 V 0 to +5 V 
Resolution (12 bit) 4.9 mV 1.2 mV 
Input impedance  100 kΩ 100 kΩ 

 

6.2 Analog inputs as counters or as event-source  

All analog inputs can be selected to function as a counter or as input for event-based 
measurements. The analog signals are sampled each 250 µs and evaluated if below or 
above the specified threshold. Hence the requirement for the analog input signal is that 
this signal is above the threshold for at least 250 µs and also below the threshold for at 
least 250 us. This implies a maximum pulse or event frequency of 2 kHz, in case the 
signal is perfectly symmetrical. 
In case of event-based measurements, time stamps of the measurement points are also 
available from the ULAB�s memory  (time resolution = 0.5 ms). If used as a counter, 
because of the above mentioned signal requirements, the maximum count-rate is 2000 
counts per second (if symmetrical signal). 
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6.3 Digital inputs 

The digital input ports labeled 5 and 6 are used for connection of digital sensors (for 
example ultrasonic motion detectors or photogates) with a left-hand BT connector. The 
digital channel can also be used for connection of an up/down counter (e.g. a bi-directional 
pulley) or for general input or output12 (4 bits per port). The left-hand BT connector has 
the following pin-outs: 
 
 

Pin Sonic Input 5 and 6 
 

 
Left-hand connector 

1 Echo (input) 1 / I/O3 
2 Init (output) 2 / I/O3 
3 Auto - ID / I/O3 
4 +5 V DC 
5 Ground 
6 I/O3  

1 Echo - Ultrasonic motion detector input, TTL 
signal 
2 Init - Distance initialization signal, TTL signal 
3 I/O: these 4 pins can be configured for digital 
input or output 
 

 

7. Dimensions 
Size:  189 mm x 105 mm x 50 mm 
Weight: approx.  0.42 kg 
 

8. Warranty 
ULAB is guaranteed completely for product quality during 12 months after the date of 
purchase. Any damage caused by operation contrary to the prescriptions in this manual 
is excluded from this guarantee. 
 

                                                 
 
12 Not supported yet. 
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VII. Troubleshooting tips 
 

Problem when  
working with ULAB 

 
Cause/Solution 

Impossible to switch ULAB on. Batteries are fully depleted.  

• Charge the batteries via the included external 
power supply.  

In case it does not solve the problem make sure that 
the batteries make proper contact.  

• Carefully unscrew the bottom part of ULAB.  

• Place the batteries correctly in the holders.  

Coach is not able to communicate 
with the connected ULAB interface 
on opening a Coach Activity or 
Result. This is the case when: 

1. the hardware settings in Coach 
are not correct; 

2. there is no interface connected 
to the computer; 

3. the Activity/Result is developed 
for another interface than ULAB; 

4. the communication between 
interface and computer is lost.  

A dialog box tells that 'Coach 
cannot initialize the ULAB panel'.  

Ad. 1. In Coach click the Install-Hardware button to 
check if the ULAB driver is installed (ULAB.dll appears 
in the column labeled �Installed�). Check the selected 
serial port number (COM) and baudrate. USB is 
detected automatically.  

Ad. 2. Connect ULAB to the computer. 

Ad. 3. Click the button 'Select other' and select 'ULAB' 
from the list. 
Note: If the Activity author did not defined 'Alternative 
panels' then this button does not appear. In this case click 
'Ignore' and switch the Panel in the Activity (see the Coach 
help, keyword 'Select other Panel'). 
Ad. 4. Reset ULAB by switching it off and on. Open 
the Activity/Result again.  

Coach is not able to communicate 
with ULAB in an Activity (you can 
see that the values on the Sensor 
icons do not change at all for a 
longer period of time. Normally, 
these values always fluctuate a little 
bit due to noise.) 

• 

Reset ULAB.  

• Right click the on-screen ULAB Panel and select 
the option 'Reset Hardware'.  

You may combine this with resetting ULAB by 
switching it off and on.  

The measurement values displayed 
on the Sensor icon or in a Window 
are not realistic. 

You have probably used a Sensor icon, which does 
not correspond to the actual sensor connected to 
ULAB.  

• 

• 

Check the ToolTip with the description of the 
Sensor icon, or look up the sensor information in 
the CMA Hardware help.  

Replace the sensor icon. 
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Appendix I. Sensors which can be used with ULAB 
ULAB allows the use sensors which produce an output voltage in the ranges  
0 to +5V or -10 to +10V. All CMA sensors (see the list below) can be directly con-
nected to ULAB. Older CMA sensors with 4-mm plugs can be connected to ULAB 
with the adapter 4-mm to BT (CMA art. nr 0519). 
Vernier and Texas Instruments sensors with BT connectors can be directly connected to 
ULAB. Older Vernier sensors and sensors of other brands such as Pasco or Fourier 
System can be connected with a proper adapter (e.g. from DIN plug to BT plug). 
 

In the table below you find the list of CMA sensors, which can be used with ULAB.  
 

Nr. CMA Sensors  Type 
013 Angle sensor (0 .. 270°)  
014 Light sensor (0 .. 200 lx)  
0141i Light sensor (0 .. 10 lx) Intelligent 
0142i Light sensor (0 .. 200 lx) Intelligent 
0143i Light sensor (0 .. 150 klx) Intelligent 
015 Sound sensor (-5 .. 5 Pa)  
016 Temperature sensor (-18 - 110 °C)  
017i Sound sensor (-45 .. 45 Pa) Intelligent 
0210i Differential Voltage sensor (-10 .. +10V) Intelligent 
0212i Differential Voltage sensor (-500 .. +500mV) Intelligent 
0221i Differential Current sensor (-5 .. +5A) Intelligent 
0222i Differential Current sensor (-500 .. +500mA) Intelligent 
023i Pressure sensor (0.. 7 bar) Intelligent 
024 Magnetic Field sensor (-100 .. 500 mT and -10 .. 50 mT)  
025i Relative Humidity sensor (0 .. 100%) Intelligent 
028 EKG-set in combination with light sensor (014 or 142i)   
029 Geiger-Müller Ionizing radiation sensor (for beta and gamma radiation)  
030i + 31 Ph-sensor (ph amplifier 030i + pH electrode 031) (0 .. 14 pH) Intelligent 
032 Baro sensor (0-1100 mbar) Intelligent13 
033 Light sensor with 3 ranges (0-600, 0-6000, 0-150000 lx) Intelligent13 
0341 Gas Pressure sensor (0-210 kPa) Intelligent13 
035 Thermocouple temperature sensor (-30 - +1400°C) Auto-id 
03517 Motion Detector (0.4 .. 6 m)  Auto-id 
0357 CO2 sensor (0 .. 5000 ppm)  
0358 Colorimeter (red, green, blue)  
0362 Force sensor with two ranges (±5N and ±50N)  
037 Heartbeat sensor  
0375 Exercises Heart Monitor sensor   

                                                 
 
13Older types of this sensor may not work as intelligent sensor.  
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0376  Dissolved Oxygen sensor (0 .. 14 mg/l) Intelligent14 
0381 Relative Humidity sensor (0 .. 100%)   
0382 Conductivity sensor (0 .. 200 µS, 0 .. 2000 µS, 0 .. 20000 µS) Intelligent14 
0384 Current sensor  (-0.8 .. 0.6mA) (I/V set) Auto-id 
0384 Voltage sensor  (-8 .. 6V) (I/V set) Auto-id 
0385 Low g accelerometer (± 5g)   
0386 Smart Pulley (includes of photogate)   
0391NH4 Ammonium (NH4+) electrode with integrated amplifier Intelligent14 
0391Ca Calcium (Ca2+) electrode with integrated amplifier Intelligent14 
0391Cl Chloride (Cl-) electrode with integrated amplifier Intelligent14 
0391NO3 Nitrate (NO3-) electrode with integrated amplifier Intelligent14 
0511 Temperature sensor (-20 - 125 °C) Auto-id 
0513 Light sensor (0 .. 10 W/m2) Auto-id 
0515 Voltage sensor  (-10.. 10V) Auto-id 
 

An Intelligent sensor has a memory chip with information about the sensor. Through a simple protocol (I2C) the 
sensor communicates with ULAB and transfers its data (name, quantity, unit and calibration) to the datalogger. 
ULAB automatically displays the calibrated values in the right unit on its screen.  
CMA delivers these sensors with standard calibrations. In the near future a special program will be available to 
enable replacing of the default calibration in EEPROM of the sensor by a calibration done by the user. This will 
be done while the sensor is connected to the ULAB datalogger. In this way the sensor can have it�s own, precise 
calibration. 
An Auto-id sensor is equipped with a specific sensor resistor, which allows automatic identification of the sensor 
by the ULAB datalogger. 
 

Appendix II. Default Sensor Library of ULAB 
For intelligent sensors ULAB reads the sensor information from the sensor EEPROM. 
For other types of sensors ULAB uses its local sensor library. By default this library 
consists of approximately 40 of the most used sensors (see the list below). Sensors that 
are not available in the ULAB sensor library can be selected in Coach and uploaded 
with the Experiment settings to the datalogger. In the near future CMA will offer a 
special program to select and upload a user-defined sensor library (based on the full 
Coach sensor library). 
 

In the table on the next page you find the list of sensors with the sensor identification 
name used in ULAB sensor library together with its full description.  

                                                 
 
14 Older types of this sensor may not work as intelligent sensor. 
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Nr. Name in ULAB   Sensor description 
Analog sensors for channels [CH1], [CH2], [CH3], [CH4] 
1 Accel5g 0385 Low g accelerometer (± 5g) (CMA art. nr 0385) 
2 Angle    013 Angle sensor (0 .. 270°) (CMA art. nr 013)
3 Baro     032 Baro sensor (0.. 1100mbar) (CMA art. nr 032) 
4 CO2     0357 CO2 sensor (0 .. 5000 ppm) (CMA art. nr 0357) 
5 ColBlue 0385 Colorimeter (CMA art. nr 0358) 
6 ColRed  0385 Colorimeter (CMA art. nr 0358) 
7 ColGreen0385 Colorimeter (CMA art. nr 0358) 
8 Cond200 0382 Conductivity sensor (0.. 200 µS/cm) (CMA art. nr 0382) 
9 Cond2k  0382 Conductivity sensor (0.. 2000 µS/cm) (CMA art. nr 0382) 
10 Cond20k 0382 Conductivity sensor (0.. 20000 µS/cm) (CMA art. nr 0382) 
11 Current 0384 Current sensor (CMA art. nr 0384) 
12 ECG      028 ECG-set (CMA art. nr 028) 
13 ExHeart 0375 Exercises Heart Monitor sensor (CMA art. nr 0375) 
14 Force5N 0362 Force sensor with two ranges ±5N (CMA art. nr 0362) 
15 Force50N0362 Force sensor with two ranges ±50N (CMA art. nr 0362) 
16 GasPres 0341 Gas Pressure sensor (0 .. 210 kPa) (CMA art. nr 0341) 
17 GMRadiat 029 Geiger-Müller Ionizing radiation sensor (CMA art. nr 029) 
18 HeartBeat037 Heart-beat sensor (CMA art. nr 037) 
19 Humidity0381 Relative Humidity (0.. 100 %) (CMA art. nr 0381) 
20 ISE-NH4 0391 Ammonium (NH4+) electrode with integrated amplifier  (CMA art. nr 0391NH4) 
21 ISE-NO3 0391 Nitrate (NO3) electrode with integrated amplifier (CMA art. nr 0391NO3) 
22 ISE-Ca  0391 Calcium (Ca2+) electrode with integrated amplifier (CMA art. nr 0391Ca) 
23 ISE-Cl  0391 Chloride (Cl-) electrode with integrated amplifier (CMA art. nr 0391Cl) 
24 Light200 014 Light sensor (0 .. 200 lx) (CMA art. nr 014) 
25 Light   0513 Light sensor (0 .. 10 W/m2) (CMA art. nr 0513) 
26 Magn500x 024 Magnetic Field sensor (-100 .. 500 mT) (CMA art. nr 024) 
27 Magn50x  024 Magnetic Field sensor (-10 .. 50 mT) (CMA art. nr 024) 
28 Oxygen  0376 Dissolved Oxygen sensor (0 .. 14 mg/l) (CMA art. nr 0376) 
29 pH       030 pH-sensor (amplifier + electrode 031) (CMA art. nr 030) 
30 Pressure 034 Pressure sensor (0 ..7 bar) (CMA art. nr 034) 
31 Pulley  0386 Smart Pulley (CMA art. nr 0386) 
32 Sound    015 Sound sensor (CMA art. nr 015) 
33 Temp     016 Temperature sensor (-18 ..110 °C) (CMA art. nr 016) 
34 Temp    0511 Temperature sensor (-25 ..125 °C) (CMA art. nr 0511) 
35 Thermcoup035 Thermocouple temperature sensor (-30 - +1400°C) (CMA art. nr 035) 
36 Voltage 0384 Voltage sensor (CMA art. nr 0384) 
37 Voltage  5V Voltmeter (Generic) 
38 Voltage 10V Voltmeter (Generic) 
Digital sensors for channels  [CH5], [CH6] 
39 Dig. Counter Digital Counter (for Digital sensors e.g. Photogates or Radiation sensors) 
40 Motion 03517 Motion Detector (0.4 .. 6 m) (CMA art. nr 03517) 
41 Rotary Low  Digital Rotary Motion Sensor (360° per turn) 
42 Rotary High  Digital Rotary Motion Sensor (1440° per turn) 



 
Appendix III. A Quick Reference Guide of basic ULAB procedures 
Home screen � Press  at any time to come back 
o the Home screen. (p. 8 lists all buttons) t
 
Help Screen � Press  during the display of the 
Help screen to keep the Help on the screen. Press 

 to go back to the Home screen. 
 
Canceling actions � Briefly press . 
 
Sensors � ULAB recognizes many sensors on connec-
tion and automatically displays data in the right units. If a 
sensor is not recognized the data is initially displayed 
uncalibrated in V. Manually select the correct sensor from 

LAB�s library (see below) to display calibrated values. U
 
Change items � Select editable items with the arrow 
keys (highlighted=selected). Press  to open the 
selection list or submenu for that item. Select with 
up/down. Confirm list item with . Briefly press 

 to cancel any action. 
 
Status information � The right side of the Large-digits, 
Graph and Table screens display status information 
about connected channels and the way these channels 
are measured, the battery status, computer connection; 
the clock and screen-specific information (e.g. co-
ordinates). See the different screen-menus. 
 
Multimeter mode � As soon as a sensor is connected, 
ULAB displays actual measurement values with a 
frequency of 4Hz for all active channels. (p. 13)  
 
Large-digits screen � In the Home screen select one of 
the channel values with the arrow keys and press . 
Use Up/Down to cycle through all connected channels.  
(
 
p. 15) 

Large-digits menu 
Press  in the Large-digits screen. Options are: 
[Dgt]  to set the number of decimals of the value 

between 0 and 4;  
[MnMx] to display the minimum, maximum and average 

values since the last reset.  
[Reset]  to set a new starting point for the [MnMx]-values 

(only if MnMx=On). (p. 15) 
 
Graph screen � Press  to see the graph. In 
Multimeter mode the graph displays the current values 
with a 4Hz frequency. Use Up/Down to select another 
channel. In Logging mode  toggles between table 
and graph. The Status information displays the x,y-co-
ordinates of the selected point. (p.18) 
 
Graph menu 
Press  in the Graph screen. Options are:  
[Move] to move the graph;  
[Zoom] to zoom in or out (Up/Down for vertical 

direction; Left/Right for horizontal direction);  
[
 
Reset] to reset the zoom factor.(p.18) 

Table screen � The Table screen is only available in 
Logging mode. It is the default screen after starting a  
measurement with . Toggle with  between 

e graph and the table. (p.17)  th
 
Table menu  
Press  in the Table screen (p.13). Options:  
[Time dgt] to set the time�s number of decimals; 
[Ch dgt] to set the number of decimals for the current 

channel. (p. 17) 
 
Experiment-settings menu � Press  in the Home 
screen. Choose the tab Sensors to view connected 
sensors or to select a sensor from ULAB�s sensor library. 
Choose the tab Method to view or change the measure-
ment settings (method; duration; sampling frequency; 
rigger settings). (p. 19) t

 
Logging mode � Press  to start storing data 

ccording to the current Experiment settings. (p.17) a
 
Add sensor � In the Experiment-settings menu go to the 
tab �Sensors�. Select a channel with the arrows. Press 

 to open the library and select a sensor. (Not all 
sensors are in ULAB�s library. If a sensor is not available, 
calibration of the data can be done afterwards in Coach). 
p. 19) (

 
Sensor modes � Press . Press . Select tab 
Sensors. Highlight 3-letter code behind desired sensor. 
�anl� � sensor measures analog values; �cnt� sensor 
measures counts; �frq� � sensor measures frequency. 

ress P . Select mode. 
 
Measurement method Press . Press . 
Select tab Method. Highlight the Type and press . 
Select TimeBased (default); EventBased or Manual. Set 
he other fields. t

 
ULAB and Coach (on-line mode) � ULAB functions as 
a normal interface with real-time display of measured 
data. Computer is master, ULAB slave (ULAB displays 

, buttons are locked). Recognized sensors appear 
automatically in Coach.  
 
ULAB and Coach (off-line mode) � Send Experiment 
settings from Coach (ULAB connected; a Set appears); 
do the experiment (ULAB not connected); Retrieve data 
in Coach (ULAB connected). 
 
Set date and time � Press  right after switching 
ULAB on. Highlight any date or time element. Press 

. Change blinking value with Up/Down. Press 

. Press .  (p.23) 
 
Reset ULAB to factory settings � Press  right 
after switching on ULAB. Highlight Restore Defaults. 
Press . 
 
Firmware update � Run ULABUpdate.exe (default in 

:\CMAC5). Follow the instructions on the screen. C
 
ULAB Screen view � Run ULABview.exe (default in 
C:\CMAC5) to transfer ULAB screens to the computer 
screen (2s refresh rate). 
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